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About Micripm

Micrium provides high-quality embedded software components in the industry by way of engineer-
friendly source code, unsurpassed documentation, and customer support. The company’s world-
renowned real-time operating system, the Micrium pC/OS-Il, features the highest-quality source
code available for today's embedded market. Micrium delivers to the embedded marketplace a full
portfolio of embedded software components that complement uC/OS-Il. A TCP/IP stack, USB
stack, CAN stack, File System (FS), Graphical User Interface (GUI), as well as many other high
quality embedded components. Micrium’s products consistently shorten time-to-market throughout
all product development cycles. For additional information on Micrium, please visit
www.micrium.com.

About pC/0S-II

Thank you for your interest in pC/0OS-Il. pC/OS-1l is a preemptive, real-time, multitasking kernel.

pC/OS-Il has been ported to over 45 different CPU architectures and now, has been ported to
NXP’s LH79520 (ARM?7) processor.

pC/OS-Il is small yet provides all the services you'd expect from an RTOS: task management,
time and timer management, semaphore and mutex, message mailboxes and queues, event flags
an much more.

You will find that pC/OS-11 delivers on all your expectations and you will be pleased by its ease of
use.

About puC/TCP-IP

PC/TCP-IP is a compact, reliable, high performance TCP/IP protocol stack. Built from the ground
up with Micrium's renowned quality, scalability and reliability, pC/TCP-IP enables the rapid

configuration of required network options to minimize your time to market. puC/TCP-IP provides
you with the highest quality source code in the industry.

BC/TCP-IP is a clean-room design and is not derived from publicly available Unix stacks, yet still
maintains compatibility with the Berkeley 4.4 socket layer interface. As with all Micrium products,
PC/TCP-IP is written in ANSI C enabling its usage with a wide array of best-of-class cross-
development tools. uC/TCP-IP can be used on 16, 32 and even some 64-bit CPUs.

PC/TCP-IP was designed specifically for the demanding requirements of embedded systems.
Critical sections were kept to a minimum and selected run-time validations can be disabled to
enhance performance. pC/TCP-IP implements zero copy buffer management for highest
efficiency.

PC/TCP-IP allows you to adjust the memory footprint based on your requirements. pC/TCP-IP
can be configured to only include only those network modules absolutely required by your system.
When a module is not used, it's not included in the build to save valuable memory space for
resource limited embedded systems.
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Licensing

pC/OS-1l and pC/TCP-IP are provided in source form for FREE for educational use or for
peaceful research.

If you plan on using pC/OS-Il in a commercial product you can evaluate pC/OS-1l and
PC/TCP-IP for FREE for 45 days and within that period, need to contact Micrium to properly
license its use in your product.

We provide ALL the source code with this application note for your convenience and to help you
experience uC/0OS-1l and pC/TCP-IP. The fact that the source is provided DOES NOT mean that
you can use it without paying a licensing fee. Please help us continue to provide the Embedded
community with the finest software available. Your honesty is greatly appreciated.
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About pC/Probe

pC/Probe is a Windows application that allows a user to display the value (at run-time) of virtually
any variable or memory location on a connected embedded target. The user simply populates
pC/Probe’s graphical environment with gauges, tables, graphs, and other components, and
associates each of these with a variable or memory location. Once the application is loaded onto
the target, the user can begin pC/Probe’s data collection, which will update the screen with
variable values fetched from the target.

pC/Probe retrieves the values of global variables from a connected embedded target and displays
the values in a engineer-friendly format. The supported data-types are: booleans, integers, floats,
and ASCII strings.

pC/Probe can have any number of ‘data screens’ where these variables are displayed. This allows
to logically group different ‘views'’ into a product.

A 30-day trial version of uC/Probe is available on the Micrium website:

http://www.micrium.com/products/probe/probe.html

Micripm pC/Probe - 05-Probe-Workspace.wsp
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Installing the Micripm Software

The source code for uC/0OS-Il and pC/TCPIP is provided in source form along with application
code that allows you to run uC/OS-1l and pC/TCPIP on the NXP LH79520 (ARM7) processor. To
install the software, simply run the self-extracting executable.

The self-extracting executable is called Micrium-NXP-uCOS-II-TCPIP-LH79520-LogicPD.exe.

You will be prompted to accept the simple terms of the licensing agreement. If you answer ‘Yes’,
the software will be installed on your PC under the \Micrium directory from the root:

I Micrium
= B AppMotes AN-1014
= ) AM1lxxx-RTOS
E:I AM1014-uCOS-TI-ARM

Licensing agreements
(If uC/OS-ll is used
commercially)

Contact £ Licers
www.Micrium.com = S":E:SIHQ
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CPU Independent £ Net IAR Example Project
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Using the Example Project

You should read AN-1014 if you are interested in further information about the port for ARM
processors.

To view the example project, start an instance of IAR Embedded Workbench, and open either the
project file LEH79520-0S-Probe-TCPIP.ewp (if you are using IAR EW v4.4x) or LH79520-0S-
Probe-TCPIP-v5.ewp (if you are using IAR EW v5.1x) located in the directory marked “IAR
Example Project” in the tree above. To do this, use the Add Existing Project... menu command
under the Project menu:

/ IAR Embedded Workbench IDE
File Edit View WS Tools ‘Window Help

O | @ oo A4y a0 e @B RS (B
add Group. .. _—
Import File List. ..
Edit Configurations. ..

Files Remove

Create Mew Project...
Add Existing Project. ..
Options, .. Alt+F7
Source Code Control 3
Make F7
Compile Chrl+F7
Rebuild Al
Clean
Batch build... Fa
Stop Build
Debug Chrl+D
Make 8 Restart Debugger

Add an existing pri el ¥

The pC/OS-IlI Kernel Awareness plugin will allow you to examine information about system objects
while using the C-Spy debugger. To gain access to this feature, enable the plug-in by right-clicking
on the project name in the work space browser and choosing Options... Then, select the
“Debugger” entry in the list box, and the “Plugins” tab pane. Find the puC/OS-Il entry in the list and,
finally, select the check box beside the entry.

IAR EWARM Versions

Be certain to open the proper project for your version of EWARM. |IAR EWARM
v4.4x will NOT open a v5.1x project. And though IAR EWARM v5.1x will open a
v4.4x project, many errors will be generated upon compilation.
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If you have opened the correct project file, but IAR gives errors because of project file compatibility
problems, verify that the following project settings (or equivalent) are in place:

1. The target device “Sharp LH79520” is selected.

2. The following “C/C++ Compiler’” = “Preprocessor” - “Additional Include Directories” are

present:

$PROJ DIRS

$SPROJ_DIRS\.
$PROJ_DIRS\.
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$SPROJ DIRS\..

PP e
e e e e e e

$PROJ DIRS\..\..

$PROJ DIRS\..\..

$PROJ DIRS\..

_—

$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..
$PROJ DIRS\..

PP e
D T Y

Options for node "LH79520-05-Probe-TCPIP"

.\BSP
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PP e
e e e e e e
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Third-Party Driver

.\ucos-ii\ports\arm\generic\iar
.\ucos-ii\source

Auc-1ib

.\uc-cpu

.\uc-cpularm\IAR
.\uC-Probe\Target\Plugins\uCOS-II
.\uC-Probe\Target\Communication

Generic\RS-232\Source
\uC-Probe\Target\Communication
Generic\RS-232\Ports\NXP\LH79520
\uC-Probe\Target\Communication
Generic\Source
\uC-Probe\Target\Communication
Generic\TCPIP\Source

.\uC-Probe\Target\Plugins\uCOS-II
.\uC-TCPIP\OS\uCOS-I I
.\uC-TCPIP\NIC

.\uC-TCPIP\IF

.\uC-TCPIP\IF\Ether
.\uC-TCPIP\NIC\ETHER\LANO91C111
.\uC-TCPIP\Source
.\uC-TCPIP\NIC\ETHER\PHY

Options for node "LH79520-05-Probe-TCPIP"

Factom Settings
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| |
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[ Preprocessor output to file
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3. The appropriate “Linker” > “Config” - “Linker configuration file” is chosen. For v4.4x, this

should be $PROJ DIRS\..\BSP\LH79520 RAM.xcl. For v5.1x, this should be
SPROJ _DIRS\..\BSP\ LH79520 RAM.icf

4. In “Debugger’ - “Setup” = “Setup macros” , no file should be selected.

Options for node "LH79520-05-Probe-TCPIP"

Categary: Factory Settings

General Options
C/C++ Compiler Output ] Bxtra Output ] Hdefine ] Diagnostics ] List Carfig l Proce 4 |
Assembler Linker command file
Custom Build
Build Actions s
BSPAULHTSR20 RAM xcl J
Debugger ﬂ Command file corfiguration tool
Simulator
Angel [ Owemide default program e
IAR. ROM-monitar o Options for node "LH79520-05-Probe-TCPIP"
J-Linkf1-Trace l"“
LML FTDL Search paths: {one per ling)
Macraigor STOOLKIT_DIRSWLIB™ .
- ‘ - LCategory: Factary Settings
Third-Party Driver Raw binary image General Options
Bl C/C++ Compiler Setup l Download ] Extra Options ] Plugins ]
|_ Assembler
Custom Build Diriver v Bunto
Build Actions - -
J-Link/J-Trace -
Linker | J |ma|n
Simulator
Angel Setup macros
IAR ROM-monitor [ Use macro file
J-Link/3-Trace
LMI FTDI | J
Macraigor Device description file
RDI

Third-Party Driver [ Qvenide defaul

0K | Cancel
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Using uC/Probe with the Example Project

As configured, the project with use the LH79520's UART1, which is connected to the only RS-232
(DB9) connector on the LogicPD evaluation board. To use puC/Probe with the example project,
perform the following steps:

1. Compile the project, load the code onto the board and begin running. The GPIO1 LED on
the evaluation board should begin to blink.

2. Start pC/Probe and open the example workspace (*.wsp) located in the directory

3. Check the options (choose “Options”
from the “Tools” menu) and confirm

that

\Micrium\Software\uC-Probe\Plugins\uCOS-I1\Workspace

a.

b.

8
RS-232
The RS-232 communicaiton J-Link
method is selected; TCRIP
UsE
A baud rate of 115200 has =} Environment
been selected; General
Options
=~ Communication
The appropriate COM
port (on your J-Link
computer) is TCRIP
selected. USE
[=F Environment
General
Screen
Target

4. Load the ELF file into the
Symbol Browser. This should
be located in the directory

Settings
(¥ R5-232 O UsSB
O J-Link (") Hew Target Server

(O TCPAP (UDF)

3

Settings
COM Port: \coM1 v|
Baud Rate: 115200 v/

ok || cancal || ooy |

\Micrium\Software\Evalboards\NXP\LH79520-LogicPD\IAR\OS-Probe-TCPIP\Flash\Exe

For IAR EW v4.4x, the file will have a *.elf extension; for IAR EW v5.1x, the file will have
*.out extension.

5. Press the “Run” button on the toolbar (a green triangle).

10
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About the Example Application

The example project includes a basic demonstration of pC/0S-Il, uC/Probe and pC/TCPIP. The
evaluation board components are labeled in the figure below. After you load the evaluation board
with the sample project, the LED will start to blink. The RS-232 port (at 115200 baud) is used for
pC/Probe, which allows you to view (in real-time) the value of static / global variables in the target
system. A 30-day trial version of this program can be downloaded from the Micrium website.

The Ethernet port is used for pC/TCPIP, which uses the external LAN91C111 NIC on the LH79520
card engine. The project, as configured, uses the static IP address 10.10.1.161, the network mask
255.255.255.0, and the gateway 10.10.10.1. If these are not appropriate for your network, you can
correct them by modifying the values used in the function AppInitTCPIP () in the code file app.c,
which is located in

/Micrium/Software/Evalboards/LH79520-LogicPD/IAR/OS-Probe-TCPIP

Once you have configured your IP address, compiled the code, and loaded your evaluation board,
you can then ping your target from a PC that is on the sme network. (uC/Probe can also be used
with the target via TCP/IP—just configure the options in the Windows program.)

See the other LH79520 projects on the Micrium for additional information about this processor and
examples applications for this evaluation board.

Ethernet
(for pC/TCPIP)

5VDC Power

RS-232
(for pC/Probe)

L

Ol

e e at
AT R o e
O

SMC LAN91C111 NIC
(lower face of card)

St 4y

——
A A om

Al

Q
L]
L

!:__ e
: 1

3

3

L o~

NXP LH79520

|
11

sesTeicions; (ARM9)

:;:v I?I ‘1 :

™ 4 LCD
G ‘. Connector

Reset PB LED

20-pin JTAG LH79520 Card
Engine

11



Micripm
puC/OS-Il, uC/Probe & uC/TCPIP for the
NXP LH79520

Erratas

If you find any errors in the documentation or code provided, please send those corrections to
Support@Micrium.com. Be sure to specify the processor, version of pC/OS-1l and any other
pertinent information about the error being reported.

Contacts

Micripm

949 Crestview Circle
Weston, FL 33327
USA

+1 954 217 2036
+1 954 217 2037 (FAX)

e-mail: Sales@Micrium.com
WEB: www.Micrium.com
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